
DriveRight 
Frequently Asked Questions 

 

General Installation  
What is the difference between DriveRight 500 and DriveRight 600? 
 
The most obvious difference is the DriveRight 600 stores up to 600 trips instead of 500 trips. 
Other features that DriveRight 600 includes are: The ability to record two digital inputs connected 
to the vehicle, the ability to record GPS inputs, the ability to have a driver user list so drivers will 
not be able to log on with a "ghost" driver ID. Also the DriveRight 600 records speed for 20 
seconds before and after a hard deceleration or accident whereas the DriveRight 500 only 
recorded speed for the 20 seconds before.  
 
 
My new DriveRight 600 will not connect to my existing wiring I used with my DriveRight 
500. 
 
That is correct. The new DriveRight 600's connector has more pins then the DriveRight 500. 
Therefore you will need the Upgrade Adapter, part # 8161. This will connect the existing wiring to 
the new DriveRight 600 
 
 
How many different ways can you install the DriveRight to a vehicle? 
 
There are actually four different ways. The easiest and preferred installation is the OBD 
installation. The other three are the VSS installation, the General Duty installation and the Heavy 
Duty installation. 

 
How do I know what installation to use? 
 
If your vehicle was manufactured in 1996 or after it will have an OBDII port. If this is the case then 
you can most likely use the OBD DriveRight installation. In this installation the OBD harness 
cable will just plug into this OBDII port. There are a few cases where this port will be present but 
will not be compatible with the OBD install kit. Please contact Technical support at 510-732-7814 
to make sure your vehicle is compatible. If your vehicle is not compatible with the OBD installation 
then the VSS installation will be the next choice. In this installation you use the VSS wire as the 
input signal. You can find where the VSS wire is on your vehicle at the www.rostra.com website. 
If your vehicle does not have the VSS wire then you will need to go with the General Duty or 
Heavy Duty installation. These installations use a magnet that is attached to your drive shaft that 
passes by a speed sensor that is mounted to vehicle. The heavy Duty is used in larger vehicles or 
in vehicles that will be used in rugged terrain. 
 
 

 



 

Do I have to put the DriveRight in a visible location? 

No, the DriveRight can be located so that the driver will not know it is being used. It would be 
advisable in this situation to turn the audible alarm off. 
 
 
Can I mount the DriveRight on a motorcycle, bus, semi-truck or tractor? 

Most likely, yes. The DriveRight uses either a reed switch/magnet combination to count rotations, 
taps into the VSS (Vehicle Speed Sensor) signal or uses the OBDII port for the signal. If you have 
access to an OBDII port, to a VSS signal, or to a drive shaft or CV joint that will allow a magnet to 
be strapped to it and enough room for the reed sensor to be mounted very close by, you should 
be able to use the DriveRight. It is important that the drive shaft or CV-joint is stable enough not 
to vibrate out of sensor range. 

 

OBDII Installation 

Where is the OBDII port located on the vehicle? 

The OBDII port is a "D" shaped port that is usually on the driver's side under the dash board. 

 

What is the calibration number when using the OBDII installation? 

Using the DriveRight software set the VSS Pulse to “VSS Other” and 75000. This sets the Pulse 
per reading to 32 and then automatically sets the calibration number to 21475 for DR 500’s and 
37748 for DR 600’s. If you are setting it manually the procedure is the same per the DriveRight 
User Guide starting on page 6. 

 

VSS Installation 

How do I find the wire with the VSS signal? 

Contact the car dealer service center for that information or go to the Rostra website 
(www.rostra.com) and see the Rostra VSS and Tach Information System. 
NOTE: Rostra is not affiliated with Davis Instruments. Rostra will not respond to Davis 
Instruments customer questions via phone or email. However, they have allowed us to direct our 
customers to their site for VSS information.  

 

GD or HD Installation 

While testing the DriveRight after GD or HD installation, I do not get the flashing dot. 

The signal from the sensor is not reaching the DriveRight. Check all of your wiring for damage or 
bad connections. Ensure the sensor and magnet are aligned with each other and that the sensor 
is within 3/8"-5/8" (10-16 mm) of the magnet when it rotates in front of it. This is illustrated in the 
installation guide 



 

 

Display 

My display is missing segments. 

Sometimes heat can cause adverse reactions in the LCD display. Remove the DriveRight to a 
cool location for an hour or so. The display should return to normal. If your DriveRight has 
incurred some sort of shock or trauma that affected the LCD display, contact Technical support. 

 

The display appears faded. 

This indicates that you are on internal power and the battery is low. It should be replaced with a 
new 3- volt lithium battery. 

 

There is nothing on the display. 

Check that you have a battery installed and that the display is connected properly to its primary, 
unswitched 12-volt source. Unswitched means a source that is not turned off by the ignition key 
or other switch. If there is a battery installed but primary unswitched 12-volt power is not 
connected, the DriveRight will go into a sleep mode in five minutes if no keys are pressed. 
Pressing the MODE key will bring it out of sleep mode. Primary unswitched 12-volt power should 
be connected when the DriveRight is used in the vehicle. 

 

There is nothing on the display and the lights are on. 

This may occur when the DriveRight is attached to primary power while in sleep mode. To restore 
the DriveRight press the MODE key to bring it out of sleep mode. If the lamp is still on press the 
"+" key while in the current setting screen. This will turn the lamp off. 

 

Incorrect or Missing Readings 

The readings on the display never change. 

The DriveRight is locked-up. Reboot the display by pressing both the MODE and "+" key at the 
same time. No log data, code information or settings will be lost when the station is rebooted. 

 
My VSS installation DriveRight reads a very high mph when I'm hardly moving or at a stop. 
 
Usually this type of problem is the result of some kind of noise from somewhere in the vehicle. It 
also could be the result of a loose connection. Sometimes the inline splice on the power supply or 
the T-tap connectors on the VSS wires don't make good connection. Check those connections to 
make sure they are secure. Also the butt splices from the harness connections sometimes cause 
problems. Make sure these are crimped well. Sometimes connecting the ground wire directly to 
the negative terminal of the battery, instead of the metal chassis of the vehicle, helps. I would 
double check the VSS signal wire.The following website has information on where to find the 



proper wire: http://www.rostra.com. Select Technical Support when you get to the home page and 
then fill in year, make and model. It will give you the VSS wire color and location. 
  
Another thing that could cause this problem is the vehicle's alarm system. Somehow the alarm 
system can interfere with the VSS signal and cause this problem. Most likely the VSS wire is also 
being used by the vehicles alarm system. A symptom of this is when DriveRights are recording 
distances when the car is parked.  You can confirm this by going to the Login screen and seeing 
if the small decimal point on the bottom left of the screen toggles on and off while the vehicle is 
parked - this decimal point changes state when the VSS signal input changes state.  If this is the 
case, we do have a new installation system that connects the DriveRight to the vehicle by just 
plugging in to the vehicle's OBD II port. This might be a solution in this case. 
 

I get no speed or distance reading. 

The signal from the sensor is not reaching the DriveRight. Check all of your wiring for damage or 
bad connections. Ensure the sensor and magnet are aligned with each other and that the sensor 
is within 3/8"-5/8" (10-16 mm) of the magnet when the magnet rotates in front of it. See your 
installation manual. 

 

My speed reading is very high or erratic. 

Your DriveRight may not be calibrated properly. Refer to your user's guide for the proper 
calibration procedure. Calibrating at 25 miles per hour will bring the acceleration, velocity and 
distance readings to a reasonable value. Calibrating the DriveRight to a distance over 20 miles 
(32 kilometers) will yield very accurate acceleration, velocity and distance readings. 

 

The distance is too low or too high. 

Your DriveRight may not be calibrated properly. Refer to your user's guide for the proper 
calibration procedure. Calibrating at 25 miles per hour will bring the acceleration, velocity and 
distance readings to a reasonable value. Calibrating the DriveRight to a distance over 20 miles 
(32 kilometers) will yield very accurate acceleration, velocity and distance readings. 

 

The start and stop times are incorrect. 

Check the time and date on the DriveRight. If these are not correct the start and stop times will be 
affected. Ensure that the signal from the sensor did not quit during operation. This will cause the 
DriveRight to believe the vehicle had stopped. 

 

 

Alarms 

What acceleration or deceleration alarm should I set? 

This will depend on how the DriveRight and vehicle will be used. Do you want to know if the driver 
uses the brake too much or only if the vehicle is decelerated at a rate that is dangerous or near to 



skidding? You will have to drive the vehicle and observe the readings that occur during normal 
operation before you can determine what is excessive. 

 

The alarm goes off when it should not. 

Check your high speed and high acceleration readings against the values in the limits screen. 
The alarm will sound when the speed, acceleration or deceleration values exceed the user set 
limits. If the high recorded values do not appear correct you may be getting erroneous readings 
due to loose or bad connections to the sensor. Check all of your wiring for damage or bad 
connections.  

Do I have to have the audible alarm on? 

No, you can choose whether the audible alarm is on or off. Toggle the alarm to ON or OFF with 
the MODE key while in the ALARM ON/OFF screen. 

 

 

Battery / Power 

How Long will the 3 volt lithium battery last? 

The DriveRight battery should last around four to six months. This is very dependant upon how 
frequently and how long the DriveRight is left on battery power. The three volt lithium battery has 
about 1300 mA hours. The DriveRight will draw approximately 5 mA while awake and about 300 
uA when it is in sleep mode. 

 

The battery indicator is on when the DriveRight is not connected to the vehicle's battery. 

This is correct. The BAT light indicates that the internal 3-volt lithium battery is in use. 

 

Will I lose data if the back-up battery is removed? 

No, data is stored in non-volatile memory and cannot be lost due to power loss. 

 

I lose time and the date when I re-power. 

That is correct. If your DriveRight is locked up and you remove power to restart it you will lose the 
time and date. If you are a driver and in a remote location and you do not have a settings code 
you will not be able to reset the time and date. The better way to restart/reset the DriveRight is to 
reboot using "+" and "mode" keys. This reboot does not affect the date or date. 

 

The BAT indicator is always on. 

The BAT indicator will be on when you are only connected to the internal 3-volt lithium battery. 
Ensure that your primary power (12-volt source) is unswitched and has not been turned off by the 



ignition. "Unswitched" means a source that is not turned off by the ignition key or other switch. 
Check the fuse and wiring to primary power and ground for damage or bad connections. 

 

When I turn the vehicle off, the DriveRight turns off. 

You are not connected to an unswitched 12-volt DC source. Unswitched means a source that is 
not turned off by the ignition key or other switch. Refer to your installation manual  for possible 
locations of an unswitched 12-volt DC source. The fuse box is a likely location. Important: Do not 
connect to a 12-volt source that is used by safety related equipment such as the horn, headlights, 
brakes, etc. 

 

Can the DriveRight drain my car battery since it is connected to unswitched power? 

A working DriveRight requires very little power and certainly would not drain a car battery. A 
DriveRight typically draws about 5 mA continuous and most car batteries are over 60 Amp Hour. 

 

My DriveRight does not function on Battery Power. 

On some of our earlier DriveRights there was a problem with IC chip U10 coming loose. This 
would cause the DriveRight not to work on battery power. This condition would have to be fixed at 
the factory. 

 

The 3 volt lithium battery I purchased at the store does not work in my DriveRight. 

We have found out from some of our customers that when they buy different brands of 3 volt 
batteries from a store or third party they can be a little smaller in size, thereby not making good 
contact with the DriveRight battery clips. The solution for this is to just bend out the negative 
battery clip of the DriveRight so that it is making better contact with the battery. 

 

Software 

Where will I find the registration number for my DriveRight software? 

If you are unsure where to look or have lost items you're in luck. We placed this very important 
number in two locations: on the registration card that comes with the product and on the front 
cover of the manual. 

 

My computer does not find the DriveRight on Auto Detect. What do I do now? 

If the auto-detect feature does not find the DriveRight then there could be a problem with your 
serial port or your serial port setup or a conflict between ports.  

Take the following steps if the software does not communicate with a DriveRight: 

Check to make sure the DriveRight console is in the CURRENT mode instead of in sleep mode. If 
the LCD screen is blank, the console is in sleep mode. Press the MODE key to put the console in 



active mode.. Check that the correct serial port is selected. If you have other programs running 
which use the serial port, such as the Palm HotSync Manager and the CarChip software, close 
those programs and try again. Check if the hardware is ok and that you have a working 
communication port. If necessary, please contact your computer vendor's Technical Support to 
check your serial port and the serial port setup. 

 

I can't find the Driver Performance Score in the Fleet Management Software (FMS). 

In the FMS the Driver Performance score was changed to the Driver Safety score. There is also a 
Driver Safety Score Summary Report. The Drive Safety Score Summary report calculates driver 
scores and average scores for each month for a 3, 6, or 12 month time period. 

 

I downloaded my DriveRight last week and again this week yet my download score in the 
Driver Safety Score Report is 0 and the max download days shows 100 although the Days 
since last download report shows 7 days. 

The Download Score in the Driver Safety Score can sometimes be a bit confusing. The days 
since last download report is just that, the number of days since you “last” downloaded.  Which, in 
this case, is 7 days. However in the Driver Safety Score report the column that is labeled Max 
Download Days is 100 because that is the largest number of days between downloads for the 
time span of the report.  

 

When using the OBD Installation the vehicle speed is off and when I look at the calibration 
number the number changed by itself. 

The vehicle speed being off is probably caused by the change in calibration number. The 
calibration number changing by itself is a bug in VMS version 2.6.1. This bug was fixed in version 
2.6.2 and is available for download on our website at no charge. 
http://www.davisnet.com/support/drive/software.asp  

 

What can I export with the Fleet Management Software (FMS) version 3.x.x? 

Using the export menu options you can export the following DriveRight FMS data. 

 FTP Export - Use the FTP Export command to export database data to a remote site. 

Export GPS to Mapping Software - Use the Export GPS to Mapping Software command to 
export GPS data in a format designed to be imported into mapping software. 

Export Accidents to Mapping Software - Use the Export Accidents to Mapping Software 
command to export accident GPS data in a format designed to be imported into mapping 
software. 

Other Export Commands - Use the other export commands to export the indicated type of data 
in a tab-delimited text file. The other types of data you can export are: company locations, 
DriveRights, driver groups, drivers, fleets, vehicles, trips, accident logs, tamper logs, trip 
addresses, days, download dates, GPS, odometer logs and safety scores. 

  



How do I Export DriveRight Data using "other export commands"? 

Use the Export "data type" command to export the data in the database to a file. The exported 
files are in a tab-delimited text file format and can be used to exchange information within your 
company, with your clients, etc. 

To export data: 

1. Select Export in the File Menu. 

2. Select the data type you wish to export (Drivers, Vehicles, Trips, Costs, etc.) from the 
drop-down menu.  

3. Create a name for the file you wish to export on the Export File Name box (for example: 
Trips.txt). 

4. Use the browse function in the Export data type to dialog box to select a destination 
where you wish to place the file. 

5. In some cases, you can use the Set Filter option to more specifically specify the data to 
be exported (for example: export only information related to one driver, or a group, or a 
period of time, etc.). 

6. If you wish you can view the file before exporting by clicking the Browse button. This will 
give you the opportunity to view the selected records that will be exported. 

7. If the data is correct, you can click the Export button to create the export data file.  

  

How do I export data using FTP? 

The FTP (File Transfer Protocol) Export shows all the available database tables that you want to 
export to the FTP site. By default all tables are selected. You can un-check the tables that you 
don’t want to export. 

Note: Before you start this operation, contact your systems administrator for your FTP account 
information. 

 Steps to follow: 

1. Select Export in the File Menu. 

2. Select the FTP Export from the menu list. The FTP Export dialog box is displayed. 

3. In the FTP Host Name box, type the name of the FTP server that you want to export the 
database tables.  

4. In order to access the FTP site you must have a user account on the FTP site. Enter your 
user name and password in the appropriate boxes. 

5. In the Remote Path box, you can enter a specific directory path in the FTP server to 
which to export your files.  

6. Default port for the FTP site is 21. Use the default port unless the FTP site listens on a 
different port. 



7. Default connection to the FTP site is active mode. Some FTP sites allow only passive 
mode connections. (Check the passive mode check box in that case). For details, contact 
your system administrator. 

8. Select the database tables to be exported by clicking the box for each table. Click a 
second time to de-select the table. 

9. If desired, you can export records that are dated within a specified time interval. The 
default start date for the interval is the last date of export. The default end date is the 
current date. You can change the start and end dates as required. If you have exported 
data previously, the last date of export is displayed in the dialog box. 

10. Click export button once you are done with the above steps.  

11. Application will create a sub-directory with your current location name on the FTP site, if it 
doesn't already exist, and then exports a ZIP file to the sub-directory. Default name for 
the export ZIP file is "day" + "month" + "year". Zip (20jan2003.zip). 

 

Should I backup data and if so how do I do it? 

The Backup feature is used to archive old data as a zip file. The backup files are stored in the 
Backup sub-directory in the DriveRight FMS install directory. The Backup sub-directory is created 
the first time you back up your data.  

The backup zip files are named based on the start and end dates chosen for the backup. For 
example, if you pick the dates between March 6, 2003 and March 27, 2003, the backup file will be 
named 6March2003_27March2003.zip. 

You can configure how much data to keep active after a backup by setting up your Automation 
Option preferences in the Setup menu. Limiting the amount of data in the active database helps 
prevent the database from growing into an unmanageable size. 

 To backup data: 

1. Click Backup in the File menu. The Backup Files to dialog box is displayed. 

2. From the Backup Files to dialog box select the folder where the backup file will be written. 
The Backup Options dialog box is displayed.  

Note: The Backup Options dialog box will not be displayed the first time you back up DriveRight 
data. 

3. In the Backup Options dialog box check your last backup date and specify whether to 
backup the whole database or only those records falling within a specified time period. 
The start date will always be initialized to the last backup date. 

4. Click OK to initiate the backup or click Cancel to exit the dialog box without backing up 
your database. 

5. When the backup is finished, click OK to return to the program. 

 

How can I download my DriveRight's data via remote modem? 

1. Click on the Help menu.  



2. Select Contents/ Index (Field 2)/ Remote Modem Setup-using HyperTerminal. The help 
file explains the procedure in detail.  

 

I cannot download my DriveRight 600 via remote modem but the DriveRight 500 worked 
fine. 

The DriveRight 600 and 500 communicate at different baud rates. In the field/remote modem you 
will need to program in the following commands AT&N0 or AT &N10 through HyperTerminal or 
similar communication programs. If a DriveRight 500 is used then the field/remote modem needs 
to be programmed with AT&N3. 

 

Smartcard and Starter Interrupter 

After installing the FMS software it does not see my desktop reader. 

The ACS setup installs 2 sets of drivers for Windows, namely PC/SC and proprietary USB 
drivers. By default the operating system allows the reader to run on PC/SC driver if it’s present in 
the system. However, in order to use the ACS reader, you have to manually change the driver 
from PC/SC mode to proprietary mode. To do this use the instructions that came with the 
Desktop reader or contact Technical support at 510-732-7814 or support@davisnet.com for the 
instructions. 

 

Can you assign multiple vehicles to one driver with the SmartCard?  

Yes, you can authorize up to five vehicles for a driver with the SmartCard. From the FMS 
software go to SmartCard/Setup Card. Select the driver. In the Vehicle (in the database) window 
all the vehicles in the database are listed. Highlight the vehicle you want to authorize for that 
driver and select the right arrow so that vehicle moves over to the Authorized Vehicle window. If 
you want to authorize another vehicle repeat this procedure.  Select the Set button and this will 
authorize those vehicles for that particular driver. 

 

I connected the Starter Interrupter as per the instructions in the manual but when I insert 
an unauthorized SmartCard in the On-Board reader the vehicle still starts. 

The diagram in the manual for the DriveRight SmartCard system on page 12 does not work on 
every vehicle. Use the Addendum to the 8116 Starter Interrupter kit.  That addendum has a wiring 
diagram that will work on more vehicles and is actually easier. If you need this addendum contact 
Technical support at 510-732-7814. 

 

There is no SmartCard Menu in my software. 

The FMS version 3.3 or later has support for the Davis SmartCard Device 

 

GPS Module 

Can I use the GPS Module with my DriveRight 500? 



No you must have a DriveRight 600 to use the GPS module. 

 

After connecting my GPS module and antenna it does not function. 

The Fleet Management software must be used to set the DriveRight to enable the GPS system. 
The DriveRight software controls the application of power to the GPS module which in turn 
supplies voltage to the GPS antenna/receiver. 

 

With your DriveRight GPS system can you track the Driver in "real time"? 

No, Our GPS systems are passive. That is it only listen and log GPS coordinates. It does not 
transmit latitude and longitude. You will not be able to check on where a vehicle currently is 
located.  You can only download the data for "after the fact" mapping. 

 

Digital Inputs 

What kind of things can I monitor with the digital inputs? 

The digital inputs can monitor any condition that has an on/off state. Examples of this include 
seatbelts, headlights, brake lights, windshield wipers, door closed, etc. 

 

Access Code 

I forgot my PIN number. 

The default code from the factory is 0000. If you entered a new code there is no way you can 
access the settings screens of the DriveRight without entering this number. If you have the Fleet 
Management Software you can examine and change the PIN code. To do this, with the 
DriveRight connected to the computer, choose "DriveRight" from the main menu of the software, 
then choose "DriveRight Settings" and then "View/Set" to update. The dialog window that 
appears will report your PIN code in the security settings. 

Davis Instrument's National Service Center can return your DriveRight code to the default for a 
fee.  

 

Usage 

Can I move the DriveRight to a different vehicle? 

Yes. The vehicle must be equipped with a full set of wiring and either the magnet / reed sensor, 
OBD or the VSS signal sensor. The magnet / reed (#8160GD), (#8160OBD) and VSS 
(#8160VSS) second-vehicle installation kits are available from Davis. See the DriveRight 
Products section of our web site. 

If you have the DriveRight software, be sure to download the data into the correct vehicle 
database. 

 



Can I differentiate the vehicles on which the DriveRight is used? 

Yes, but only with the Fleet Management Software. Every DriveRight has an internal ID number 
that is visible only in the DriveRight software. This ID number is matched to a vehicle database to 
ensure that the data is not downloaded to another vehicle's database. 

 

I have one DriveRight in one vehicle that has many different drivers. How many drivers can 
use one DriveRight? 

The DriveRight offers a Driver ID Code to differentiate between drivers. To monitor the driving of 
multiple drivers, assign each driver a unique 4-digit ID code. Access the Driver ID Code Entry 
Screen to enter the Driver ID code. Each DriveRight can support up to 9999 drivers using ID 
codes 0001 to 9999. 

 

Can I tell when and for how long the vehicle stopped throughout the day? 

Yes, with the DriveRight 600 and the Fleet Management Software (FMS). The DriveRight 600 
logs the start and end time of each trip. Using the FMS, you can list the vehicle's trip statistics, 
including start and stop times, for whatever period you wish. This will tell you when the vehicle 
was in motion and when it wasn't. 

 

Can I get information related to an accident from the DriveRight? 

The DriveRight 600 has room in memory for 10 accident logs which show the vehicle's speed for 
the 20 seconds before and after a sudden deceleration. Information is written to the accident log 
any time the vehicle exceeds the unit's set deceleration limit. Also, the last 20 seconds of trip 
information for each of the last 20 trips is saved in the accident log. The information in the 
accident log may be downloaded, viewed, printed and stored using the Fleet Management 
Software. 

 

What happens when a driver enters a driver ID code not on the DriveRight 600 drivers 
llist? Will the car start? 

Yes the car will start. The only thing that will happen is the DriveRight will go into alarm to alert 
the driver he put in the wrong ID code. If he does not know the right code the alarm will stop after 
a short time. If he puts in three wrong codes the ID will go to 0000 and the alarm will stop. The 
data for that trip will go to the default driver of that vehicle or if there is no default driver for that 
vehicle the data will go to the "unknown" driver. 

 

What happens when 600 trips are exceeded on the Trip 600 DriveRight? 

After 600 trips, the DriveRight will write the next trip over the oldest trip data in the DriveRight. 

 
 


